



BAB I
PENDAHULUAN

1.1. [bookmark: _TOC_250021]Latar Belakang

Banyak industri mengalami perkembangan yang sangat pesat sebagai akibat dari kemajuan teknologi saat ini. Ini disebabkan oleh fakta bahwa teknologi memegang peringkat tertinggi dalam industri. Inovasi baru-baru ini muncul dalam dunia industri, yang diyakini dapat membantu mempercepat proses dan tetap menghasilkan produk yang baik. Dengan demikian, pada Tugas Akhir, mahasiswa diminta untuk menerapkan pengetahuan yang mereka peroleh dari perkuliahan ke industri. Penulis memilih "LEMIGAS" Balai Besar Pengujian Minyak Gas Bumi (BBPMGB) sebagai lokasi Tugas Akhir karena memenuhi kompetensi yang ada.

Lembaga penelitian dan pengembangan pemerintah yang berlokasi di Kementerian ESDM, Balai Besar Pengujian Minyak Gas Bumi (BBPMGB) "LEMIGAS" berada di bawah Unit Eselon I Badan Penelitian dan Pengembangan (Balitbang) Energi dan Sumber Daya Mineral. Pusat lemigas melakukan pengujian, penelitian, dan pengembangan batuan, minyak, dan gas alam. (Dunia, 2022) Penulis saat ini melakukan magang lanjutan di LEMIGAS dengan fokus pada pelaksanaan Tugas Akhir Industri. Spesifiknya, penulis terlibat dalam proyek tugas akhir di gedung Eksploitasi. Di area ini, terdapat sejumlah Oven yang penggunaanya masih dilakukan secara manual.

Dalam proses pengujian batuan diperlukan tahap penting yaitu tahap pemanasan untuk untuk menghilangkan kadar air atau senyawa kimia yang   terkandung didalam batuan tersebut yaitu untuk mengetahui porositas didalam bantuan berapa cairan yang masuk pada pori-ori batuan. (Alim, Firdausi, & Nurmalasari, 2017). Maka untuk memudahkan proses pengujian diperlukan teknologi modern untuk memasang komponen elektronik pada tubuh Oven. Proses ini memungkinkan produksi komponen dengan cepat, bersih, teratur, dan efektif.
 Pada area pengujian di Gedung Eksploitasi, terdapat masalah yang perlu diatasi. Oven yang digunakan masih manual pemanasan batuan dilakukan selama kurun waktu 2-3 hari dalam kondisi Oven menyala Nonstop karena suhu didalam Oven harus dijaga, pemanasan ini dilakukan untuk menghilangkan kadar air sehingga adanya kesulitan ketika pengujian user harus standby untuk megawasi suhu dan penimbangan secara manual pada batuan untuk mengetahui kadar air atau minyak pada tahap awal theatment batuan dan kadar air atau minyak yang hilang setelah dilakukan pemanasan batuan, penimbangan dilakukan secara manual.

Berdasarkan permasalahan yang telah disinggung diatas, Penulis perlu melakukan improvement. Memodifikasi Oven Grieve tersebut dari analog menjadi digital dengan membuat sistem pengontrolan di dalam oven dimana nantinya sistem ini akan membaca dan menampilkan suhu aktual dan kelembaban pada oven serta mengetahui depresiasi pada batuan, sehingga akan memudahkan user untuk mengetahui detail informasi dan masalah yang terjadi. Dengan pengembangan Sistem Monitoring dengan memanfaatkan sensor DHT22, NodeMCU ESP32, dan loadcell. Sistem ini akan menggantikan sistem manual dengan otomatis dengan berbasis IOT dengan menggunakan aplikasi Bylnk dalam proses monitoring dan tracing dengan meminimalisir terjadinya kesalahan dalam pengujian.




1.2. [bookmark: _TOC_250020]Perumusan Masalah
Berdasarkan latar belakang, Adapun rumusan masalah yang akan diterapkan yaitu:
1) Bagaimana cara membuat program pada Oven Grive Pemanas Batu?
2) Bagaimana mengintegrasikan program dengan seluruh sistem monitoring suhu dan nilai depresiasi pada batuan?
1.3. [bookmark: _TOC_250019]Tujuan
Adapun tujuan yang ingin dicapai yaitu:
1) Membuat sistem program untuk mengontrol Oven Grieve Pemanas Batuan melalusi sistem IoT.
2) Menampilkan kondisi suhu, kelembaban dan nilai depresiasi pada sistem dan   diintegrasikan berbasis IoT.
1.4. [bookmark: _TOC_250018]Luaran
a. Bagi Lembaga Pendidikan dan Perusahaan
Akan dibuat Sistem Monitoring Pada Oven Grieve Pemanas Batuan BBPMGB “LEMIGAS” berbasis IOT dengan harapan dapat mempermudah Perusahaan atau User dalam melakukan pengujian secara efektif dan efisien
b. Bagi Mahasiswa
· Laporan Tugas Akhir
· Draft Artikel Ilmiah











BAB II
TINJAUAN PUSTAKA

2.1 NodeMCU ESP32

[image: ]

Gambar 2. 1 NodeMCU ESP32
(Sumber : https://www.arduino.biz.id/2022/08/ -32.html)

Pada (Gambar 2.1) ialah gambar pin dari NodeMCU ESP32. NodeMCU ESP32 adalah sistem berdaya rendah pada seri chip (SoC) dengan Wi-Fi & kemampuan Bluetooth dua mode. ESP32 menggunakan mikroprosesor Tensilica Xtensa LX6 dual – core atau single core dengan clock rate hingga 240 MHz. ESP32 sudah terintegrasi dengan built-in antenna switches, RF balun, power amplifier, low - noise receive amplifier, filters, and power management modules. ESP32 merupakan penerus dari ESP8266 yang cukup populer untuk Aplikasi IoT Pada ESP32 terdapat inti CPU serta Wi-Fi yang lebih cepat, GPIO yang lebih banyak, dan mendukung Bluetooth Low Energy. (Sanaris & Suharjo, 2018)





Tabel 2. 1 Spesifikasi ESP 32

	
	Spesifikasi ESP 32

	Model Modul
	ESP31-WROOM-32

	Protokol
	Wifi: 802.11 b / g / n
Bluetooth: BT V4.2 BR / EDR + BLE

	Frekuensi Wifi
	2.4Ghz – 2.5Ghz

	Ukuran Modul
	18mm x 25.5mm x 3.1mm

	Sumber Daya Listrik
	3.0 – 3.6V

	Suhu Operasi
	-40°C - 85°C

	Arus Minimum 
	500 mA

	Flash Memori
	4MB



2.2 Internet Of Things (IoT)

Internet of things atau dikenal juga dengan singkatan IoT, merupakan sebuah konsep yang bertujuan untuk memperluas manfaat dari konektivitas internet yang tersambung secara terus menerus. Cara kerja Internet of things adalah interaksi antara 3 program mesin yang terhubung secara otomatis dan dapat dikendalikan oleh user dari jarak jauh. (Sanaris & Suharjo, 2018)




Dengan semakin berkembangnya infrastuktur internet, kita akan menuju fase berikutnya di mana akses internet akan mencakup lebih dari smartphone atau komputer. Namun, berbagai benda nyata akan terhubung ke internet. Untuk menjalankan Internet of Things (IoT), internet berfungsi sebagai penghubung antara kedua interaksi mesin tersebut, dan pengguna hanya perlu bertindak sebagai pengatur dan pengawas bagaimana alat tersebut bekerja secara langsung. Konsep Internet of Things (IoT) memungkinkan pekerjaan dilakukan dengan lebih cepat, mudah, dan efisien. (Nopriawan, 2018)
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2.3 SENSOR DHT22




[image: ]

Gambar 2. 2 Sensor DHT22
(Sumber : http://surl.li/jwkdo )

Pada (Gambar 2.2) merupakan gambar dari sensor DHT22. DHT22 adalah suhu dan kelembaban sensor digital senyawa yang output dikalibrasi sinyal digital. Berkat teknologi akuisisi modul khusus digital dan suhu dan kelembaban penginderaan teknologi diterapkan pada modul, DHT22 datang dengan keandalan yang sangat tinggi dan stabilitas jangka panjang yang sangat baik. (Utama, 2016)
DHT22 termasuk sensor kelembapan kapasitif dan suhu mengukur elemen NTC yang terhubung ke kinerja tinggi 8-bit mikrokontroler, sehingga kualitas yang sangat baik, waktu respon super cepat, kemampuan anti interferensi yang kuat dan sangat hemat biaya. Dibandingkan dengan suhu SHT10 dan sensor humiditiy, DHT22 menikmati presisi tinggi dan harga yang lebih rendah, menjadikannya pilihan ideal untuk rentang pertengahan harga, suhu & kelembapan kinerja tinggi sensor. (Sanaris & Suharjo, 2018)
Spesikasi DHT22 yang digunakan yaitu tegangan 3.3-6 VDC, dengan suhu 400C – 800C, kelembaban 0% – 100% RH, arus 2.5 MA, dan akurasi 2-5%.

2.4 Load Cell
 
Gambar 2.3 Sensor Load Cell
(Sumber : http://surl.li/jwkew )

[image: ]
Load cell adalah sebuah transducer yang dapat menghasilkan output secara proporsional dengan beban atau gaya yang diberikan. Load cell dapat memberikan pengukuran yang akurat dari gaya dan beban. Load cell digunakan untuk mengkonversikan regangan pada logam ke tahanan variabel sehingga menghasilkan sinyal listrik yang besarnya sebnading dengan berat yang diukur. (Sari, Utami, Samsugi, & Ramdan, 2020)
Tabel 2.2 Spesifikasi Load Cell


	Spesifikasi Load Cell

	Bahan Keseluruhan
	Aluminium

	Tipe
	Single Point (CZL635)

	Kapasitas Pengukuran
	20kg

	Presisi
	0.05%

	Tegangan Eksitasi
	5 VDC



2.5 Modul HX711

HX711 merupakan sebuah modul timbangan dengan komponen yang terintegrasi dari “AVIA SEMICONDUCTOR” dengan kepresisian 24-bit ADC yang didesain untuk sensor timbangan digital dan aplikasi industri yang terkoneksi dengan sensor jembatan wheatstone. HX711 terdiri dari beberapa komponen yang saling terintegrasi antara lain yaitu kapasitor, resistor, transistor dan IC HX711 yang berfungsi sebagai regulator, penguat, osilator sehingga dapat mengeluarkan data output digital. (Sari, Utami, Samsugi, & Ramdan, 2020) pada gambar2.4 merupakan gambar modul HX711 :
[image: ]

Gambar 2. 4 HX711 Load Cell
(Sumber : http://surl.li/jwkew )


2.6 Relay 2-Channel

Pada dasarnya relay berfungsi sebagai saklar yaitu memutus/menyambungkan arus listrik berdasarkan arus yang masuk ke input relay. Pada sistem elektrik, relay biasanya terpasang diantara fuse/sikrin dan beban. Fungsinya untuk mengamankan bila terjadi short. Relay terdiri dari 4 komponen dasar, yaitu: Electromagnet (Coil), Armature, Switch, dan spring. Relay mempunyai 2 jenis kondisi kontak   point, yaitu Normally Close dan Normally Open. Normally Close adalah kondisi awal sebelum diaktifkan akan berada diposisi Close (tertutup) atau biasanya terhubung. Sedangkan Normally Open adalah kondisi awal sebelum diaktifan   akan   berada pada kondisi Open (terbuka) atau biasanya tidak terhubung. (Manullang, Seragih, & Hidayat, 2021)
Secara sederhanya berikut ini prinsip kerja dari relay : ketika coil mendapaat listrik (energized), akan timbul gaya elektromagnet yang akan menarik armature yang berpegas, dan contact akan menutup. Gambar 2.5 merupakan gambar pin dari relay 2- Channel
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Gambar 2. 5 Relay 2-Channel 
(Sumber: http://surl.li/jwkfq )


Adapun spesifikasi dari module relay 2 channel, sebagai berikut:
1. Menggunakan tegangan rendah, 5V, sehingga dapat langsung dihubungkan pada sistem mikrokontroler.
2. Tipe relay adalah SPDT (Single Pole Double Throw): 1 COMMON, 1 NC (Normally Close), dan 1 NO (Normally Open).
3. Memiliki daya tahan sampai dengan 10A.
4. Pin pengendali dapat dihubungkan dengan port mikrokontroler mana saja, sehingga membuat pemrogram dapat leluasa menentukan pin mikrokontroler yang digunakan sebagai pengendali.
5. Dilengkapi rangkaian penggerak (driver) relay dengan level tegangan TTL sehingga dapat langsung dikendalikan oleh mikrokontroler.
6. Driver bertipe “active high” atau kumparan relay akan aktif saat pin pengendali diberi logika “1”.
7. Driver dilengkapi rangkaian peredam GGL induksi sehingga tidak akan membuat reset sistem mikrokontroler.

2.7 Blynk
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Gambar 2. 6 Aplikasi Blynk
 (Sumber : http://surl.li/kcbfp )

Blynk merupakan aplikasi yang dirancang untuk Internet of Thinks (IoT). Aplikasi ini dapat digunakan untuk mengendalikan perangkat hardware, menampilkan data sensor, menyimpan data, visualisasi, dan lain lain. Blynk diracang untuk conrol dan monitoring hardware secara jarak jauh menggunakan komunikasi data internet atau internet. Kemampuan Kemampuan untuk menyimpan data dan menampilkan data secara visual baik menggunakan angka, warna ataupun grafis semakin memudahkan dalam pembuatan project dibidang Internet of Things. (Palaha, Ermawati, Machdalena, & Arya, 2021)





[image: ]2.8 Arduino IDE
Gambar 2.7 Arduino IDE
(Sumber : http://surl.li/jyhxc )

Arduino IDE (Integrated Development Environment) adalah software yang di gunakan untuk memprogram di arduino, dengan kata lain Arduino IDE sebagai media untuk memprogram board Arduino. Arduino IDE bisa di download secara gratis di website resmi Arduino IDE. Arduino IDE ini berguna sebagi text editor untuk mebuat, mengedit dan juga mevalidasi kode program. bisa juga digunakan untuk meng-upload ke board Arduino. Kode program yang digunakan pada Arduino disebut dengan istilah Arduino “sketch” atau disebut juga source code arduino, dengan ekstensi file source code .ino. Seperti teks editor pada umumnya yaitu memiliki fitur untuk cut /paste dan untuk find / replace teks. Pada bagian keterangan aplikasi memberikan pesan balik saat menyimpan dan mengekspor dan juga sebagai tempat menampilkan kesalahan. Konsol log menampilkan output teks dari Arduino Software (IDE), termasuk pesan kesalahan yang lengkap dan informasi lainnya. Pojok kanan bawah jendela menampilkan papan dikonfigurasi dan port serial. Tombol toolbar memungkinkan Anda untuk memverifikasi dan meng-upload program, membuat, membuka, dan menyimpan sketch, dan membuka monitor serial. (Sanaris & Suharjo, 2018)

Integrated Development Environment (IDE) adalah program yang dapat digunakan untuk menulis program ke dalam ESP32. IDE ini mencakup editor, compiler, dan uploader Sketch, dan dapat digunakan untuk menulis program ke dalam ESP32. Bahasa C adalah bahasa pemrogamannya.


2.9 Batu Pasir
Batu Pasir merupakan salah satu jenis batuan sedimen yang umumnya tersusun atas material klastik atau hasil erosi batuan sumber, serta dapat berasal dari daratan hingga lingkungan pengendapan laut. Umumnya, batupasir tersusun atas berbagai mineral, baik yang tergolong stabil seperti kuarsa, zirkon, ataupun mineral lain yang tergolong tidak stabilseperti feldspar, serta litik atau fragmen batuan yang ikut terendapkan ketika proses transportasi berlangsung. Banyak sedikitnya kandungan mineral pada batupasir tersebut tidak terlepas dari sifat stabilitas mineral itu sendiri, serta kandungan mineral pada batuan sumber. Sehingga, kandungan mineral pada batupasir dapat menjadi penunjuk asal batuan sumber (provenance), yaitu dengan memperhatikan kelimpahan butiran detritus sedimen didalamnya. (Jannah & Hastuti, 2022)
Porositas dan permeabilitas adalah dua sifat fisik batuan yang sangat penting untuk menyimpan dan mengalirkan/melewatkan minyak dan gas bumi dalam batuan reservoir (wadah) di bawah permukaan bumi. Semakin besar porositas suatu batuan reservoir migas, maka volume/cadangan migas semakin besar, dan semakin besar permeabilitas, maka radius pengurasan migas dan recovery factoratau RF (persentase volume gas yang dapat diambil) dari suatu reservoir, akan semakin besar. (Rahman & Rahmawati, 2021).

BAB III
PERENCANAAN DAN REALISASI

3.1. [bookmark: _TOC_250016]Rancangan Alat

Perangkat keras (hardware) dan software (software) adalah komponen yang diperlukan untuk membangun sistem pemanas pada oven berbasis Internet of Things selama proses pembuatan. Pada Tugas Akhir yang penulis kerjaan yaitu dengan mengubah oven yang sebelumnya analog menjadi digital dengan hal ini agar memudahkan penggunaan dan pengawasan pada proses pemanasan. Modifikasi ini dengan membuat sistem menampilkan suhu, kelembaban, dan berat yang akan tertampil pada LCD dan berbasis IoT.
3.1.1 Flowchart Perancangan Alat
Pada diagram alir ini dijelaskan proses perancangan alat dari proses identifikasi masalah sampai dengan pengambilan data.
	
           [image: ]
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Gambar 3.1 Flowchart Perancangan Alat

3.1.2 [bookmark: _TOC_250015]Deskripsi Alat

	Nama Alat
	:
	Modifikasi Analog To Digital Dan Mengetahui Depresiasi Pada Batuan Serta Monitoring Oven Grieve Pemanas Batuan BBPMGB “Lemigas”
Berbasis IOT

	Fungsi Alat
	:
	Sistem pemanas Oven pada Monitoring suhu, kelembaban dan nilai depresiasi pada batuan
berbasis Internet Of Things

	Nama Sub Sistem
	:
	Algoritma Pemrograman Monitoring Pada Oven Grieve Pemanas Batuan BBPMGB “LEMIGAS”

	Fungsi Sub Sistem
	:
	Membuat program untuk mengontrol Oven Grieve Pemanas Batuan berbasis IOT



Alat ini dibuat sebaik mungkin menggunakan fitur pendukung untuk memaksimalkan modifikasi dari alat ini. Adapun fitur pendukung tersebut adalah sebagai berikut ini:

1. Alat ini menggunakan 2 buah sensor yang berfungsi untuk mendeteksi dan menghitung 3 parameter yang terdapat di dalam oven, yaitu DHT 22 sebagai pendeteksi suhu dan kelembapan. Load Cell Single Point sebagai pengukur berat dari sampel.
2. Menggunakan mikrokontroler ESP 32 sebagai penghubung dan pengendali sensor dan komponen lainnya serta sebagai penghubung dengan internet untuk proses IoT.
3. Menggunakan LCD 4x20 sebagai monitoring parameter dari suhu, kelembapan, berat yang terdapat dari dalam oven, serta memantau penyusutan/depresiasi pada batuan.
4. Menggunakan plot lamp sebagai indikator yang menandakan bahwa heater menyala.
5. Menggunakan blynk sebagai pengontrol oven dan menyediakan grafik data dari kestabilan suhu serta penyusutan (depresias) pada batuan.

3.1.3 [bookmark: _TOC_250014]Cara Kerja Alat
Tahap – tahap sistem pemonitor proses pemanas Batuan berbasis IOT:
1. Power supply dihubungan dengan tegangan 24 Volt untuk menyalakan sistem didalam oven.
2. Switch digunakan untuk mengatur keadaan mode pada oven, apabila switch dalam keaadan Off maka sistem IOT bisa dilakukan melalui Bylnk dan dalam keadan On maka Oven dilakukan secara manual.
3. Koneksi ESP32 berindak sebagi otak dari sistem ini. Sensor DHT22 dan load cell akan terhubung ke ESP32.
4. ESP32 akan mengontrol pemanas oven melalui relay yang akan dihubungkan pada heater. ESP32 akan membaca data dari sensor DHT22 untuk monitor suhu didalam oven
5. Kemudian, ESP32 akan membaca data dari loadcell untuk memonitor berat benda di dalam oven.
6. Komunikasi dan kontrol pada ESP32 dihubungkan melalui Aplikasi bnylk merupakan komunikasi berbasis IOT melalui jaringan Wifi.
7. [bookmark: _Hlk143553557]Kemudian sebagai antar muka pengguna memgintergerasikan melalui layar LCD dan aplikasi bylnk, untuk menampilkan suhu, kelembaban, berat serta mengatur pengaturan suhu oven.
8. ESP32 dapat mengumpulkan data suhu, kelembaban, dan berat mengirimkannya melalui koneksi Aplikasi Bylnk.

[bookmark: _TOC_250013]Berdasarkan data yang dikumpulkan alat ini mngimplementasikan sistem kendali otomatis untuk megatur dan menjaga suhu dan berat yang diinginkan

3.1.4 Spesifikasi Alat

Sistem monitoring oven untuk pemanas dan mengetahui nilai depresiasi pada batuan berbasis IOT berbentuk seperti Gambar yaitu terdiri dari sensor DHT22, Load Cell yang diatur menggunakan mikontroler ESP8266. Alat ini terbagi membaca 3 proses yaitu menampilkan suhu, kelembaban dan nilai depresiasi.
1) Bentuk Fisik
Desain sistem pemonitor dalam proses pemanasan pada oven untuk mengetahui suhu dan nilai depresiasi berbasis Internet Of Thingas yang terdiri dari sensor DHT22, Load Cell, ESP32 dan aplikasi Blynk. Alat ini terbagi menjadi 3 proses yaitu merubah bentuk analog ke digital, membuat sistem IoT, mengetahui perbandingan depresiasi antar batuan.

	A. Ukuran Oven
	:
	Panjang = 36,5 cm Lebar = 29 cm
Tinggi = 47 cm

	B. Bahan Oven
	:
	Stainless

	C. Ukuran Box
	:
	Panjang =22 cm
Lebar =31 cm Tinggi = 19 cm

	D. Bahan Box
	:
	Kerangka = Besi
Penutup = Akrilik



2) Spesifikasi Software
Keseluruhan sistem diprogram menggunakan sofware Arduino IDE dengan menggunakan Bahasa C. Berikut Spesifikasi Software serta spesifikasi menu dan submenu software pada Arduino yaitu pada tabel 3.1 dan 3.2.

Tabel 3. 1 Spesifikasi Software

	Software
	Version
	Menu

	Arduino IDE
	1.2.13
	File, edit, Sketch,
Tools, Help.









Tabel 3. 2 Spesifkasi Menu dan Submenu Software

	Nama Menu
	Sub Menu

	File
	New, Open, Open Recent, Sketchbook,
Example, Close, Save, Save As ,Page Setup, Print, Preferences, Quit.

	Edit
	Undo, Redo, Cut, Copy, Copy for Forum, Copy as HTML, Paste, Select All, Go to line, Comment/Uncomment, Incease Indent, Decrease Indent, Increase Font Size, Decrease Font Size,
Find, Find Next, Find Previous.

	Sketch
	Verify/compile, Upload, Upload, Upload Using Programmer, Export Compiled Binary, Show Sketch Folder. Include
Library, Add File

	Tools
	Auto Format, Archive Sketch, Fix Encoding&Reload, Manage Libraries, Serial Monitor, Serial Plotter, WiFi101/WiFiNINA Firmware Updater, Board: “Arduino Uno”, Port, Get Board Info, Programmer: “AVRISP mkll”,
Burn Bootloader.

	Help
	Getting Started, Environment, Troubleshooting, Reference, Find in. Reference, Frequently Asked Questions,
Visit Arduino.cc, About Arduino.



3.1.4 Diagram Blok
Input pada diagram blok (Gambar 3.3 ) yaitu sensor DHT22 berfungsi untuk mendeteksi suhu dan kelembaban dan Load Cell yang berfungsi untuk mengukur berat batuan selama proses pemanasan. Input digunakan dan data diproses oleh mikrokontroler NodeMCU ESP8266. Sinyal keluaran dari input yang sudah diproses oleh mikrokontroler sebagai proses data I/O dan mengirimkan data yang akan ditampilkan pada display dan aplikasi bylnk. Kemudian Outputnya yaitu Display LCD yang menampilkan suhu, kelembaban dan berat serta menyimpan database.

[image: ]


Gambar 3. 3 Diagram Blok sistem

Keterangan diagram blok (Gambar) merupakan sistem pemonitor proses pemanasan oven untuk mengetahui nilai suhu, kelembaban, dan nilai depresasi pada batuan berbasis Internet Of Things.

Tabel 3. 3 Keterangan Diagram Blok Sistem

	Nama
	Keterangan

	NodeMCU ESP32
	Berfungsi sebagai mikokontroler untuk
mengelola data dari sensor.

	DHT22
	Mendeteksi suhu dan kelembaban di
dalam Oven Pemanas.

	Nama
	Keterangan

	Load Cell
	Mendeteksi berat di dalam Oven.

	Display
	Sebagai penampil hasil sebagai
antarmuka pengguna terhadap hasil dari sistem.

	Blynk
	Platfrom berbasis IoT dapat mengontrol Mikrokontroler dan Monitoring jarak jauh.



3.1.5 Flowchart

	
                                                  [image: ]
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Gambar 3. 3 Flowchart Sistem kerja alat

3.2 [bookmark: _TOC_250012]Realisasi Alat
Berdasarkan hasil perencanaan alat yang telah dibuat, selanjutnaya adalah proses realisasi alat. Pada bagian ini akan dijelaskan mengenai tahapan pembuatan program untuk sistem monitoring pemanas batuan. Proses pembuatan programan ini menggunakan software Arduino IDE. Proses perancangan perangkat lunak meliputi tiga tahap, yaitu pemrograman mikropengendali ESP32, pemrograman aplikasi komputer dan perancangan antarmuka tampilan. Untuk lebih detail tentang Monitoring program dapat melihat flowchart Pada gambar 3.4.
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Gambar 3.4 Flowchart Sistem Monitoring






3.2.1 [bookmark: _TOC_250011]Pemrograman Software

Pemrograman Mikropengendali ESP32

Pemilihan platfrom Arduino (https://arduino.cc) tersebut berdasarkan kemudahan sintaks pemrograman yang digunakan, dukungan berkas pustaka (library) untuk perangkat-perangkat yang dipakai dan dukungan komunitas. Program yang berjalan di ESP32 tersebut memiliki alur kerja sebagaimana pada Gambar 3.5 :

[image: ]

Gambar 3. 5 Flowchart Alur kerja program



Menggunakan ESP32 Pada Arduino IDE
1. Buka Arduino IDE, Klik Menu File >Preferences

Pada kolom Additional,  masukan link berikut	: https://raw.githubusercontent.com/espressif/arduino-esp32/gh- pages/package_esp32_index.json


Tampilan 3. 1 Memasukan Github ESP32

Ketika link tersebut telah terdeteksi oleh ARDUINO IDE maka board ESP8266 dapat di-install. Caranya dengan memilih menu tools dan pilih board lalu board manager kemudian cari ESP8266 lalu klik install.









2. Klik menu Toolas > Board: > Pilih Boards Manager > Ketik ESP32 lalu Install
[image: ]

Tampilan 3. 2 Memilih Board ESP32
[image: ]

Tampilan 3.3 Menginstall ESP32

Jika board sudah ter-install, pilih board NodeMCU ESP32 dan pilih port serial yang terhubung dengan mikrokontroler.

3. Install selesai, Klik menu Tools > Board: > ESP32 DEV Module
[image: ]

Tampilan 3. 4 ESP32 Dev Module

4. Menginstall Library
[image: ]Install library pada Arduino IDE untuk memudahkan pengguna dalam penulisan Sketch atau Program hal ini diperlukan untuk memasukan setiap library pada komponen agar bisa dilakukan pemrograman. Dibawah ini pada gambar 3.10 menunjukan Library yang sudah tersedia

Tampilan 3.5 Tampilan Library Arduino 

Cara Install Library

1. Menggunakan Library Manager
a) Sketch > Include Library > Manage Libraries
b) Cari file library yang ingin diinstal dan pilih versi > Intall
c) Periksa tag “INSTALLED” di samping nama library
2. Mengimpor Library .zip hasil Download
a) Sketch > Include Library > Add. ZIP Library
b) Cari file library yang ingin ditambahkan lalu pilih “Open”


2. Coding Program Sistem
[image: ]Selanjutnya setelah melakukan install libraray maka mulai menuliskan program sistem monitoring pada suhu, kelembaban dan berat. Seperti tampilan 3.6 
Tampilan 3. 6 Coding program

3. Mengubungkan blynk

Bylnk adalah aplikasi IOS dan OS Android untuk mengontrol Arduino yang dipakai ialah ESP32. Aplikasi ini dapat digunakan untuk mengendalikan perangkat hardware, menampilan data sensor dan menympan data. Pada tampilan 3. 12 ialah tampilan dari Bylnk pemanas batuan.

[image: ]\

Tampilan 3.7 Bylnk pemanas batuan

Menghubungkan ESP32 ke platform Blynk melibatkan beberapa langkah. Blynk adalah platform IoT untuk mengontrol perangkat dan mengumpulkan data melalui aplikasi seluler. Berikut adalah cara menghubungkan ESP32 ke Blynk:
Langkah 1: Buat Proyek Blynk
a) Buat proyek baru dengan menekan tombol "+ Create New Project".
b) Pilih perangkat yang sesuai, seperti ESP32, dalam menu dropdown. 
Langkah 2 :Token Autentikasi
Setelah proyek dibuat, akan mendapatkan Token Auth yang akan digunakan ESP32 untuk menghubungkan ke proyek Blynk. Token ini diperlukan agar perangkat dapat berkomunikasi dengan server Blynk.
Langkah 3: Siapkan Perangkat ESP32
a) Pastikan telah menginstal Arduino IDE dan mengkonfigurasi Arduino IDE untuk memprogram ESP32.
b) Buka Arduino IDE, buka menu File > Examples > Blynk > Boards_WiFi > ESP32.
Langkah 4: Konfigurasi Kode
a) Buka kode dalam Arduino IDE.
b) Ganti nilai "auth" dengan token autentikasi yang Anda dapatkan dari proyek    Blynk.
c) Konfigurasi WiFi dengan mengganti nilai "ssid" dan "pass" sesuai dengan  jaringan WiFi.
d) Sesuaikan kode sesuai kebutuhan, seperti mengatur pin GPIO dan fungsi          yang sesuai dengan perangkat.
Langkah 5: Upload Kode ke ESP32
a) Sambungkan ESP32 ke komputer melalui kabel USB.
b) Pilih papan dan port yang sesuai dalam menu "Tools" di Arduino IDE.
c) Klik tombol "Upload" untuk mengunggah kode ke ESP32. 
               Langkah 6: Monitor Serial
	Setelah kode diunggah, buka monitor serial di Arduino IDE untuk melihat   keluaran debug dan melacak status koneksi ESP32 ke Blynk.
3.2.2 [bookmark: _TOC_250010]Skematic sistem
[image: ]
Gambar 3. 6 Skematic Sistem



Konfigurasi rangkaian koneksi (Gambar 3.13) sensor load cell, HX711, DHT22 dan ESP32. Sensor load cell berkapasitas 1 kg dipilih karena berat batuan berkisar antara 50 ± 100 gram. Modul HX711 sebagai instrumen penguat mengkonversi sinyal analog menjadi digital Kabel merah, hitam, putih, dan hijau pada sensor load cell dihubungkan secara berurutan dengan pin E+, E-, A-, A+ pada HX711. Pin VCC pada modul HX711 dihubungkan ke pin +5V ESP32. Pin GND pada modul HX711 dihubungkan ke pin GND ESP32. ESP 32 sebagai pengendali sistem oven pemanas berbasis IoT yang dimana ESP 32 menggunakan serial komunikasi wifi. Pada rangkaian diatas DHT 22 berfungsi sebagai pendeteksi suhu dan terdapat juga heater sebagai sumber penghasil panas pada oven. LCD sebagai display yang akan menampilkan suhu, kelembapan dan berat yang dideteksi dari sensor.

BAB VI
PEMBAHASAN

4.1. [bookmark: _TOC_250008]Pengujian Program Alat

Alat Modifikasi Oven Pemanas Batuan dan Mengetahui Depresiasi Serta Monitoring Batuan Berbasis IoT yang sudah dirancang yang kemudian dilakukan pengujian dari jalannya program dalam sistem yang bekerja. Tujuan dari pengujian ini adalah utnuk menegtahui apakah program yang dibuat pada Arduino IDE berjalan dengan baik dan dapat dilakukan pengujian depresiasi pada proses pemanasan.
4.1.1 [bookmark: _TOC_250007]Deskripsi Pengujian

	Lokasi
	Gedung Sarana Litbang BBPMGB, LEMIGAS

	Hari, Tanggal
	Senin, 31 Juli 2023

	Pelaksana
	1. Dewita Aura Agesti
2. Roberto Felix Siagian
3. Siti Nuraviah

	Tujuan Pengujian
	Mengetahui apakah program dapat terhubung dengan komponen dan terhubung berjalan dengan baik serta mengetahui nilai derpesiasi antar batuan dengan membandingkan peroses
depresiasi antar dua jenis batuan.


Berikut ini merupakan alat dan bahan yang digunakan dalam pengujian program:
Tabel 4.1 Alat dan Bahan Pada Pengujian

	Alat /Bahan
	Fungsi
	Jumlah

	Laptop HP  Ryzen 5-5625U
	Melihat data
	1

	Mikrokontroler ESP32, sensor DHTT2 dan Sensor Load Cell 
	Sebagai pengendali dan sensor yang akan diuji 
	1

	Software Arduino IDE
	Aplikasi pemrograman ESP32
	1

	Alat/Bahan
	Fungsi
	Jumlah

	Kabel USB
	Koneksi alt menuju laptop
	1

	Sample Batuan 
	Bahan Uji Coba
	1


[bookmark: _TOC_250006]
4.1.2 Prosedur Pengujian Kelayakan 

1. Siapkan alat beserta bahan seperti yang tercantum pada tabel di atas.
2. Siapkan program software Arduino Ide.
3.  Siapkan sensor dan mikrokontroler
Berikut adalah langkah-langkah yang dilakukan dalam proses pengujian
1. Persiapan Perangkat dan Perangkat Lunak
a) Siapkan Arduino board (seperti Arduino Uno, Arduino Nano, dll.).
b) Sambungkan sensor DHT22 dan load cell ke Arduino sesuai petunjuk koneksi yang diberikan oleh masing-masing sensor.
c) Instal Arduino IDE di komputer Anda dan pastikan board Arduino Anda sudah terkonfigurasi dengan benar.
2. Instalasi Library:
a) DHT22: Unduh dan pasang library DHT untuk Arduino. Anda dapat   melakukannya melalui menu "Sketch" > "Include Library" > "Manage Libraries", lalu cari dan instal library DHT.
b) Load Cell: Jika diperlukan, instal library yang sesuai untuk load cell. Misalnya, jika Anda menggunakan load cell dengan HX711 sebagai antarmuka, Anda perlu menginstal library HX711.



3. Kode Pengujian
Memasukan atau membuat coding untuk mebuat sistem monitoring bahasa C  menggunakana software Arduino IDE.
4. Pemantauan Hasil
a) Hubungkan Arduino ke komputer melalui kabel USB.
b) Buka Serial Monitor di Arduino IDE (Ctrl+Shift+M) untuk melihat hasil pengukuran suhu, kelembaban, dan berat dari load cell.
5. Analisis Hasil
Pastikan bahwa nilai yang ditampilkan di Serial Monitor masuk akal dan sesuai dengan kondisi lingkungan dan beban pada load cell.

Berikut merupakan serial monitor yang terbaca oleh sensor, dimana menunjukan nilai suhu, kelembaban dan berat. 

Tampilan 4.1 merupakan serial Monitor pada Sensor DHT22 untuk mengetahui suhu dan kelembaban, pada tampilan tersebut suhu yang terbaca merupakan suhu ruangan.
[image: ]

Tampilan 4.1 Serial Monitor DHT22
Tampilan 4.2 merupakan tampilan serial monitor pada sensor load cell sebagai pendeteksi Berat didalam oven.
[image: ]
Tampilan 4.2 Serial Monitor pada load cell



Pada Tampilan 4.3 serial monitor ESP32 akan menghasilkan IP Address yang nantinya akan dimasukan ke server Bylnk untuk menghubungkan ESP32 dengan Bylnk agar tersambung pada internet dan bisa digunakan dengan berbasis IoT.
[image: ]

Tampilan 4.3 Serial Monitor ESP32

Pada tampilan 4.4 ialah tampilan serial monitor pada seluruh sistem yang diintegrasikan oleh seluruh sensor yang ada yaitu DHT22 dan Load cell, dimana untuk suhu yang tertera yaitu suhu ruangan dimana heater belum aktif dan load cell dalam keadaan kosong dan belum terkalibrasi. Maka sebelum batuan dimasukan kedalam oven kondisi load cell dilakukan kelibrasi (Terra).

[image: ]

Tampilan 4.4 Serial Monitor pada Sistem



4.1.3 [bookmark: _TOC_250005]Data Pengujian Program 

             Tabel 4. 2 Data Pengujian Kelayakan Program
	Nama Item
	Status
	Keterangan

	
	Berfungsi
	Tidak
	

	DHT22
	
	-
	Sensor dapat terbaca oleh
 serial monitor serta berfungsi mendeteksi suhu dan kelembaban

	Load Cell
	
	-
	. Sensor dapat terbaca oleh
 serial monitor serta berfungsi mendeteksi berat

	NodeMCU 32
	
	-
	
Mikrokontroler dapat berfungsi dan terhubung pada Wi-Fi

	LCD
	
	-
	
 Display berfungsi dan menampilkan suhu, kelembapan, dan berat yang dihasilkan dari sensor.

	Blynk
	
	-
	Dapat befungsi sebagai monitring
 sistem 





	Pengujian dilakukan dengan menapilkan pada serial monitor dan tertampil nilai pembacaan pada sensor seperti nilai berat, kelembaban dan berat. 

	Tabel 4.3 Tabel Pengujian Program
	Data Tertampil Pada Serial Monitor

	No
	Waktu (Second)  
	Suhu
	Kelembaban
	Berat

	1
	1 
	24.40
	38.70
	4.2

	2
	2
	24.40
	38.60
	4.0

	3
	3
	24.40
	38.70
	4.0

	4
	4
	24.40
	38.70
	4.3

	5
	5
	24.40
	38.70
	4.4

	6
	6
	24.40
	38.60
	4.2

	7
	7
	24.40
	38.60
	4.1

	8
	8
	24.40
	38.70
	4.2

	9
	9
	24.40
	38.60
	4.0

	10
	10
	24.40
	38.70
	3.9

	Rata- Rata
	24.40
	38.66
	4.1



	
	*Suhu (°C), Kelembaban (%), Berat(gram), waktu (Second)














	Tampilan 4.5 Grafik Pengujian Program
	
	

	Pada tabel 4.3 dan grafik 4.5 diatas data yang dimasukan sebanyak 10 data dengan selilish pembacaan selama 1 detik. Dimana pada suhu secara konstan terbaca dengan nilai yang sama yaitu 24.40 °C sedangkan pada kelembaban terjadi penurunan 0,1 % hal ini disebabkan dengan faktor lingkungan dikarenakan pada saat pengujian dilakukan pada ruangan Ber AC sehingga ini mejadi salah satu faktor perbedaan pembacaan untuk nilai kelembaban. Pada pembacaan Load Cell dengan nilai yang berubah-ubah dikarenakan penulis menggunakan tipe load cell single point dimana pembavcaan hanya berfokus oada satu titik serta rentan terhadap getaran dan udara pun berpengaruh. Sehingga itu yang menyebabkan perbedaan pembacaan pada load cell. Pada tabel diatas didapatkan dari pembacaan dengan rata-rata suhu 24.40°C , rata-rata kelembaban 38.66 % dan rata-rata berat 4.1 gram.
		Pada tampilan 4.5 merupakan tampilan dari aplikasi Bylnk dimana disana teraca nilai pada suhu, kelembaban dan berat. Kondisi pembacaan ini ketika pengujian sedang berlangsung dimana sample batuan yang diuji untuk mengetahui nilai depresiasinya.


[image: ]
					
Tampilan 4.6 Sistem tertampil pada blynk



      4.1.4  Analisis Data	

Pada pengujian program menggunakan Arduino IDE berjalan dan berhasil sehingga pada tampilan realisasi program terdapat data yang diambil dari serial monitor yaitu data sensor DHT22 dan load Cell yang terbaca oleh ESP32 serta sistem terhubung oleh aplikasi Blynk sebagai perangkat IoT. Data yang tertampil pada serial monitor dihasilkan sensor DHT22 dengan kondisi membaca suhu ruang. Sehingga, data yang tertampil pada serial monitor terbaca 24°C dan nilai kelembaban tergantung pada kondisi suhu pembacaan yang terdeteksi 38.60 %- 38.70% . Pada pembacaan load cell terbaca di 4.2 gram- 3.9 gram. Pada sistem terdapat delay pada tiap proses 50 detik untuk mengelola program.
Dari data yang diperloleh pada suhu secara konstan terbaca dengan nilai yang sama yaitu 24.40 °C sedangkan pada kelembaban terjadi penurunan 0,1 % hal ini disebabkan dengan faktor lingkungan dikarenakan pada saat pengujian dilakukan pada ruangan Ber AC sehingga ini mejadi salah satu faktor perbedaan pembacaan untuk nilai kelembaban. Pada pembacaan Load Cell dengan nilai yang berubah-ubah dikarenakan penulis menggunakan tipe load cell single point dimana pembacaan hanya berfokus oada satu titik serta rentan terhadap getaran dan udara pun berpengaruh. Sehingga itu yang menyebabkan perbedaan pembacaan pada load cell. Maka dari pembacaan data melalui serial monitor didapatkan pembacaan dengan rata-rata suhu 24.40°C , rata-rata kelembaban 38.66 % dan rata-rata berat 4.1 gram
Dengan perolehan data tersebut, maka dapat disimpulkan bahwa alat dapat berfungsi dengan baik seperti yang tertampil yang di mana modifikasi oven analog menjadi oven digital berhasil dan berfungsi seperti yang diinginkan. LCD yang dapat menampilkan data suhu, kelembapan, dan berat dari dalam oven serta perangkat IoT yang dapat terhubung dengan sistem dan dapat dimonitor dari jarak jauh melalui aplikasi Bylnk.

Grafik Pengujian Progaram

Suhu	
1	2	3	4	5	6	7	8	9	10	24.4	24.4	24.4	24.4	24.4	24.4	24.4	24.4	24.4	24.4	Kelembaban	
1	2	3	4	5	6	7	8	9	10	38.700000000000003	38.6	38.700000000000003	38.700000000000003	38.700000000000003	38.6	38.6	38.700000000000003	38.6	38.700000000000003	Berat	
1	2	3	4	5	6	7	8	9	10	4.2	4	4	4.3	4.4000000000000004	4.2	4.0999999999999996	4.2	4	3.9	Waktu (Second)
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//4detine CAYENNE_DEBUG

#define BLUNK PRINT Serial
#include <HiFi.h>

#include CHiFiClient.h>
#include <BlynkSimpleEsp32.h>

"

#include "HKTLL.A"
#include "soc/rec.h”
#include <stdlib.h>
#include ciire.h>
#include <SimpleTimer.h>

const int LOADCELL DOUT_PIN = 33
const int LOADCELL_SCK_PIN = 3

BXTLL scale;

"
int rbutton

£loat weight;
cat calibration factor = -113.00; // for me this vlaue works just perfect 206140

8: // this button will be used to reset the scale to 0.

"

1/ WiFL newvork info.
//ehar ssiar] i // nama disesuaikan
//char passl] = "P@ssw0zd"; //pasword disesusiken

//cnar ssid(]
//cher passl] =

"AndroidAg”; // nama disesuaikan
"buanl2345"; //pasword disesuaiken

char ssid(] = "WiFi-LMG"; // nama disesusikan
char pass(] = "lemigas2020"; //pasword disesusiken

BlynkTiner timer;

//char auth(] = "TMPLEWLII1ShL"
//char auth(] = "Monitoring Suhu";
//char auth(] = "WSQEEN:YrsxAPuvnJSRQFXrOXWSABEDa";

//4define BLYNK TEMPLATE_ID "TMPLELCOOTCSV"
//3define BLYNK TEMPLATE NAME "Monitoring Batuan LMG"™
//4detine BLYNK AUTH_TOKEN "aL4OK6dzyVs)T£5-XIz4FbiodmGkHIY2"

#define BLYNK TEMPLATE_ID "TMPL62L SKWEH"

-357.2
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